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◆システム条件◆

・ OS Windows XP (32 Bit), Windows Vista (32 Bit), Windows 7 (32 Bit)

・ 画面解像度 1280x1024(SXGA)以上

・ グラフィックスカード DVI-D信号出力があること

・ 通信インターフェース シリアルポート、またはUSB-Serial変換アダプター

・ 対応フォトメーター KONICA MINOLTA CA-210
X-Rite i1 Display 2
Jeti Specbos (with FTDI driver v.2.8.24)

・ フォトメーターインターフェース USBポート（上記いずれも）

・ 対応モデル DT-V20L1D
DT-V24L1D
DT-V17L2D
DT-V17L3D
DT-V20L3D
DT-V20L3G
DT-V24L3D
DT-R17L4D
DT-V17G1
DT-V21G11
DT-V24G1
DT-3D24G1
DT-E17L4G
DT-E21L4
DT-V17G15
GD-323D20

■ご用意していただくもの

・ パソコン 上記、システム条件を満たすもの　1台
・ フォトメーター 上記、対応フォトメーターに記載のあるもの　どれか1台
・ モニター 上記、対応モデルに記載のあるモニター　どれか１台
・ シリアルケーブル（RS-232C) ストレートケーブル(D-sub 9pin）　１本
・ インストールファイル 弊社ホームページよりダウンロードしてください。
・ ライセンスコード 弊社ホームページの所定フォームよりお問い合わせください。

http://www3.jvckenwood.com/support/mail/pro_sys.html

■接続図

※本アプリケーションは無償ツールであり、動作および調整精度については保証しかねます。
調整精度は調整環境、ご使用のフォトメーターの精度等により大きく異なる場合が想定されます。
お客様の責任の範囲にてご利用いただけますようお願い致します。

※Windowsは米国Microsoft Corporationの米国およびその他の国における登録商標です。
※その他記載している会社名、製品名は各社の商標及び登録商標です。

シリアルケーブル
USBケーブル等
（各フォトメーターの仕様による）

フォトメーターモニター

パソコン

測定

システム条件
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◆インストール方法◆

※古いバージョンがすでにインストールされている場合には、アンインストールをしてから行ってください。

１．インストールCDをPCのドライブに挿入してください。または、インストールファイルの入ったメディアを挿入してください。

２．インストールファイル内にある"Setup.exe"を実行して、インストールを開始してください。

３．下記の図に従ってインストールを完了させてください。
※ Microsoft Visual C++ 2010 再頒布可能パッケージがインストールされていないPCをお使いの場合は、
本ツールのインストール作業の前に、上記パッケージをインストールする必要があります。
Microsoft Visual Studioをインストール済みであれば、上記パッケージをインストールする必要はありません。

・Nextボタンをクリックしてください。

・利用規約をお読みください。

インストール方法
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・"I Agree"を選択し、Nextボタンをクリックしてください。

・お名前と会社または所属名を入力し、Nextボタンをクリックしてください。

・インストール先のフォルダを選択してください。特に変更がなければ、そのままNextボタンをクリックしてください。

インストール方法
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・Nextボタンをクリックしてください。インストールが開始します。

・インストールが完了するまでしばらくお待ちください。

・インストールが完了しました。Closeボタンをクリックしてください。

インストール方法
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４．アプリケーションの実行

PCのデスクトップ上の"Monitor Calibration"のショートカットアイコンをダブルクリックしてください。
または、プログラムメニューから"Monitor Calibration"を選択してください。
メインアプリケーションウインドウが開きます。

最初はデモモードとして起動されます。
デモモードを解除する場合は、メニューバーから、"Help"→"Register License"に入り、
12文字のライセンスコードを入力して"OK"ボタンをクリックしてください。

ライセンスコード入力完了時

※Windows Vista、Windows 7をお使いの場合、"コンピュータの管理者"権限を持つユーザーアカウントにて行ってください。
デモモードを解除させるためにはコンピュータ管理者アカウントで実行する必要があります。

この問題を解決するためには以下の方法があります。
① Administratorアカウントでログインする。
② "Monitor Calibration"のショートカットアイコンを右クリックしてプロパティを開き、"セキュリティタブ"でフルコントロールを
チェックし、Administratorとしてアプリケーションを起動する。

※ライセンスコードの入手方法については、別途お問い合わせください。

No Licence

インストール方法
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◆アンインストール方法◆

※ユーザーアカウントに「コンピュータの管理者」権限が必要です。管理者権限のアカウントでログインしてください。

１．「コントロールパネル」から「プログラムの追加と削除」を選択し、ダブルクリックしてください。

２．プログラム一覧から「JVC Monitor Calibration」を選択し、削除をクリックしてください。

アンインストール方法
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◆メインウインドウ画面の説明◆

メインアプリケーションウインドウには、以下のエリアで構成されています。
① メニューバー
② トポロジー
③コントロールセンター
④ガンマ
⑤ホワイトバランス
⑥モニターケーパビリティ

① メニューバー
"File"、"Extension"、"Help"の３つのメニューがあります。

■ File
キャリブレーション対象であるガンマ、ホワイトバランスおよびバックライト輝度のデータ（NVRAM）をロード、セーブができます。
また、アプリケーションの終了もここから行います。
※ Load NVRAMと"Save NVRAM"はモニターとの通信の確立（コネクト）がされていないと選択できません。

・Load NVRAM
以前保存したNVRAMデータをモニターにロードすることができます。
※データの拡張子は"～.dat"です。
※モデル名と関連付けて記録されているため、異なったモデルに対して読み込みした場合はエラーとなります。
データまたはモニターを確認してください。

・Save NVRAM
現在コネクトされているモニターのNVRAMデータをPCに保存することができます。
※データの拡張子は"～.dat"です。

・Exit
本アプリケーションを終了します。
"Yes"を選択し、アプリケーションを終了させてください。

①

② ③

④ ⑤

⑥

メインウインドウ画面の説明
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■ Extension
キャリブレーションに関する各種設定を行うことができます。

・Monitor
キャリブレーション対象モニターとPCの接続に関する設定です。

Monitor ID： モニターIDに合わせることで、コネクト時間を最小にすることができます。初期値はAUTOです。

　 Port： シリアルポートのCOMポート番号に合わせることで、コネクト時間を最小にすることができます。
初期値はAUTOです。

・Sensor
キャリブレーションに使用するフォトメーターに関する設定です。

Model： 使用するフォトメーターを選択します。
※CA-210, i1 Display2, i1 Display3/Pro(OEM Ver.), Jeti Specbosに対応しています。(Ver.3.0.2)
※フォトメーターがコネクト済の状態でこの選択を行う場合は、コネクトを解除するダイアログメッセージが
　 表示されます。

Ch： CA-210の測定チャンネルを選択することができます(0～99ch）。CA-210を選択した場合のみ選択できます。
初期値は0chとなっています。特定のチャンネルで測定したい場合は、チャンネルの設定を行ってください。

・White Balance
ホワイトバランス調整に関する設定です。
本キャリブレーションでは、高階調側をGain、低階調側をOffsetというパラメータを用いて調整します。

Level(Gain）： 高階調側のホワイトバランスの調整を行う信号レベルを設定します。（0～100%）初期値は70%です。
Level(Offset）：低階調側のホワイトバランスの調整を行う信号レベルを設定します。（0～100%）初期値は30%です。

※フォトメーターは一般的に低輝度映像に対する感度が十分でないため、
　 Offset調整を行う信号レベルを低くしすぎてしまうと良い調整結果が得られないことがあります。
※"RESET"ボタンをクリックすれば初期値に戻ります。

メインウインドウ画面の説明
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・Calibration Mode
キャリブレーションモードを選択できます。
または、キャリブレーションプロセス開始時にモードを選ぶように設定することもできます。

　 ガンマ/ホワイトバランス（輝度）を調整するモード

ホワイトバランス（輝度）のみ調整するモード

キャリブレーションプロセス開始時にモードを選ぶ

・Backup Option
キャリブレーションプロセス開始時にNVRAMデータバックアップのダイアログを表示するかどうかを設定できます。

キャリブレーションプロセス開始時に
NVRAMデータバックアップダイアログを表示させる

キャリブレーションプロセス開始時に
NVRAMデータバックアップダイアログを表示しない

・Measurement Type
測定モードにおける測定対象パラメータを選択する設定です。

最小/最大輝度を測定するモード

ガンマ/ホワイトバランスを測定するモード

■ Help
本ソフトウェアのライセンスコードの入力、ヘルプの閲覧、バージョン情報表示が行えます。

・Register License
本ソフトウェアを使用するため（デモモードの解除）に必要なライセンスコードを入力できます。
下記画面に16文字のライセンスコードを入力後、OKボタンをクリックしてください。
正しいコードが入力されると、デモモードを解除することができます。

デモモード解除後

・Help Contents
本ソフトウェアの詳細な説明を見ることができます。
必要システム条件や、対応機種、対応フォトメータなども見ることができます。

No Licence

メインウインドウ画面の説明
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・About this software
本ソフトウェアのバージョン情報を見ることができます。

メインウインドウ画面の説明
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② トポロジー
モニター、PC、そしてフォトメーターのコネクト状態を表示します。
コネクトは、モニター、フォトメーターの順番で行います。

コネクト前

モニターとのコネクト中

モニターのコネクト完了

フォトメーターとのコネクト中

フォトメーターのコネクト完了（キャリブレーション開始準備OK）

■モニターとのコネクト（通信の確立）
アプリケーション上の"Connect"ボタンをクリックしてください。
モニターとPCのコネクトが完了すると、コネクションラインが緑色に変わります。
・ もしコネクトが終わらない場合や成功しなかった場合には、ケーブルが正しく接続されているかチェックしてください。
もしくは、アプリケーションを終了させ、対象モニターの電源を一度オフし、数秒経った後、再びオンさせてください。

※アプリケーションが何かの問題で終了してしまった場合もこの方法を試してください。
・ コネクト中に"Cancel"ボタンをクリックすれば中断することができます。

コネクトが完了すると、"Connect"ボタンが"Disconnect"ボタンに変わります。
モニターをコネクト解除する場合は"Disconnect"ボタンをクリックしてください。

また、コネクト完了後、モニターの画にカーソルを当てると、NVRAMデータのセーブ/ロードを行うこともできます。

メインウインドウ画面の説明
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■ フォトメーターとのコネクト（通信の確立）
アプリケーション上の"Measure"ボタン、または"Calibrate"ボタンをクリックしてください。
フォトメーターとPCのコネクトが完了すると、コネクションラインが緑色に変わります。
※ Target Gammaを一つ以上チェックしていないと、"Measure"ボタン、"Calibrate"ボタンは有効になりません。
・ もしコネクトが終わらない場合や成功しなかった場合には、ケーブルが正しく接続されているかチェックしてください。
そして、フォトメーターがWindowsシステムにデバイス認識されているか確認してください。
もし認識されていなかった場合には、おそらくドライバーが正しくインストールされていないと思われます。
そのような場合にはフォトメーターのドライバーを再インストールしてください。

・ コネクト中に"Cancel"ボタンをクリックすれば中断することができます。

また、コネクト完了後、フォトメーターの画にカーソルを当てると、フォトメーターの選択を行うこともできます。

下記ダイアログで"Yes"を選択するとコネクトが解除されるとともに、フォトメーターの選択を行うことができるようになります。

・ CA-210のコネクトについて
CA-210をコネクトしようとすると下記ダイアログが表示されます。

これは、CA-210のゼロキャリブレーションを行うためのものです。
ゼロキャリブレーションを行う場合は、CA-210のプローブリングを"0-CAL"の位置に回し、OKボタンをクリックしてください。
ゼロキャリブレーションが完了すると下記ダイアログが現れますので、プローブリングを"MEAS"に戻し、
OKボタンをクリックしてください。

メインウインドウ画面の説明
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③コントロールセンター
キャリブレーションプロセスの開始、キャリブレーションレポートウインドウの表示を行うことができます。

キャリブレーションプロセスを開始
※Target Gammaを一つ以上チェックしていないと有効になりません。

キャリブレーションレポートウインドウを表示

■ Calibrateボタン
Calibrateボタンをクリックするとキャリブレーションプロセスを開始します。
モニター、フォトメーターのコネクトがされていない場合は、まずコネクトを開始します。

■ Reportボタン
Reportボタンをクリックすると、キャリブレーションレポートウインドウが開きます。
このウインドウでは、過去レポート表示(Open)、レポートの保存(Save As)、レポート印刷(Print)ができます。

④ガンマ
ガンマ調整パラメータとして、下記の設定を変更できます。
(1) ターゲットガンマ値（設定可能範囲：1.0～3.0）
(2) ガンマ調整ポイント数（16, 32, 64, 128, 256）

(3) ターゲット最大輝度値[cd/m
2
]

①調整したいガンマLUTのチェックボックスをクリックしてください。複数選択可能です。
ここでチェックマークがついているガンマLUTがキャリブレーション対象となります。

② ターゲットガンマ値を設定してください。（設定可能範囲：1.0～3.0）
初期値は、LUT#1＝2.2, LUT#2＝2.35, LUT#3＝2.45, LUT#4＝2.6です。
LUT#2～4および、DICOM93、DICOM65の選択可否は、対象モニターの機種によって変わります。

③ガンマの調整ポイント数を設定してください。（16, 32, 64, 128, 256）
初期値は、"16"です。
ポイント数が多ければ（特に低階調部において）ガンマ調整結果は良くなりますが、調整時間は長くなります。

④ ターゲット最大輝度値[cd/m
2
]を設定してください。

※対象モニターの最大輝度を上回る輝度値に設定にした場合、対象モニターの最大輝度値に自動的に設定されます。
同様に、対象モニターの最小輝度を下回る輝度値に設定にした場合、対象モニターの最小輝度値に設定されます。

※対象モニターの最大輝度および最小輝度は自動的に測定され、"Monitor Capability"の部分に表示されます。
※ DICOMターゲット輝度は、DICOM対応機種のみ設定できます。
※この設定は主に、複数のモニター間で表示輝度を合わせる目的で使用されます。

⑤ホワイトバランス
ホワイトバランス調整パラメータを設定できます。

① "White Balance"部分のタブで設定色温度を選択します。
9300K、6500K、USERが選択可能です。
9300Kは9314Kをターゲットとして、6500Kは6504Kをターゲットとして設定されており変更はできません。

② USERは色温度のターゲットを3000～10000Kの範囲で変更可能です。
"Color Temperature"のテキストボックスか、"x", "y"のテキストボックスから設定できます。
"x", "y"に値を入力した場合、計算された色温度が"Color Temperature"に反映されます。

※ DICOM対応機種では、DICOM93は9300K、DICOM63は6500Kをターゲットとして調整されます。

(1)

(2)

(3)

①

②

メインウインドウ画面の説明
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⑥モニターケーパビリティ

測定モードを開始し、モニターが表示可能な最小輝度Lmin(cd/m
2
)、最大輝度Lmax(cd/m

2
)を表示します。

測定モードを開始
※Target Gammaを一つ以上チェックしていないと
 有効になりません。

"Measure"ボタンをクリックすると測定モードを開始します。
モニター、フォトメーターのコネクトがされていない場合は、まずコネクトを開始します。

測定モードは以下の2種類があり、メニューバーからExtension→Measurement Typeで選択します。

・ 最小/最大輝度を測定するモード
黒色テストパターンと白色テストパターンを表示し、それぞれの輝度を測定します。
その測定値を、現在のモニターの設定状態における表示可能な最小輝度Lmin、最大輝度Lmaxとして表示します。
Lmin、Lmaxは9300K、6500K、USERのそれぞれの色温度に対して測定されます。

※ DICOM93のLmin、Lmaxは9300Kタブ、DICOM65のLmin、Lmaxは6500KタブのDICOM欄にそれぞれ表示されます。

測定完了後

・ ガンマ/ホワイトバランスを測定するモード
キャリブレーションプロセスと同様に、下記ダイアログが表示されます。
このダイアログウインドウをドラック＆ドロップで、測定を行うモニターの画面上に移動させ、"OK"ボタンをクリックしてください。
モニターの画面に測定用テストパターンが表示され、ガンマおよびホワイトバランスの測定が開始されます。

測定モードが開始されると、メインアプリケーションウインドウは最小化され、
下記測定ステータスウインドウが表示されます。
プログレスバーは各ステップの進行状況を示しています。完了したステップにはチェックマークがつきます。

測定が完了すると下記画面になります。
OKボタンをクリックするとメインウインドウが再表示され、レポートウインドウが新たに開きます。

レポートウインドウの詳細は、"Monitor Calibrationツールの使い方　６．キャリブレーションレポート"を参照ください。

メインウインドウ画面の説明
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◆Monitor Calibrationツールの使い方◆

はじめに

正しくキャリブレーションを行うために、下記の点にご注意ください。

・ モニターの電源を入れた直後は、輝度・色度が安定しないため、調整に適しません。
正しく調整を行うために、モニターの電源を入れて60分以上エージングしてください。

・ モニターのボリュームコントロールはすべてセンターに戻してください。
また、モニターの設定をすべて初期化（All Reset）してください。（詳細は各モニターの取扱説明書を参照してください。）

・ フォトメーター（キャリブレーションセンサー）はモニターの画面中心に設置してください。
密着型のフォトメーターを使う場合には、画面に強く押さえつけすぎないようにしてください。

・ 周辺光の影響を防ぐために暗室で作業するか、または厚く黒い布を被せて行ってください。
・ PCのグラフィックカードのガンマ設定を"1.0"にし、ブライトネス、コントラストを初期値設定にしてください。
・ キャリブレーションを実行する前に、NVRAMデータのバックアップをしておくことをおすすめします。
・ キャリブレーションを中断した場合、それまでの調整結果がモニターに更新されてしまいます。
元の状態に戻したい場合は、NVRAMデータのロードを行ってください。

・ キャリブレーションプロセス開始から完了までの時間の目安は約30分です。（設定、調整環境により変わります。）

■キャリブレーションフロー

ガンマ/ホワイトバランス/輝度の目標値や調整パラメータを設定します。

ホワイトバランス調整のみ行うか、すべての項目を調整するかを選択できます。

する しない

※ホワイトバランス調整のみを選択した場合、ガンマ調整は行いません。

アプリケーション起動

モニターコネクト

メインウインドウ表

キャリブレーション目標設定

フォトメーター選択

キャリブレーションプロセス実行

フォトメーターコネクト

キャリブレーションモード選択※

NVRAMデータバックアップ選択

バックアップ

調整用テストパターン表示

ホワイトバランス/輝度調整

ガンマ調整

レポート表示

完了

Monitor Calibrationツールの使い方
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１．アプリケーションの起動

PCのデスクトップ上の"Monitor Calibration"のショートカットアイコンをダブルクリックしてください。
または、プログラムメニューから"Monitor Calibration"を選択してください。
メインアプリケーションウインドウが開きます。

２．モニターとPCの接続（コネクト）

①モニターの電源を入れセットアップしてください。
②シリアルケーブル(ストレート)、または、USB-シリアル変換ケーブルを用いて対象モニターに接続してください。
③ DVI-Dケーブルを用いて対象モニターのDVI-D入力端子に接続し、PCの画面をモニターに表示させてください。
※ PCのグラフィックカードがマルチ画面対応の場合は、拡張デスクトップ画面で表示しても問題ありません。

④アプリケーション上の"Connect"ボタンをクリックしてください。モニターとPCの通信の確立(コネクト)が開始されます。
コネクトが完了すると、コネクションラインが緑色に変わります。
・ もしコネクトが終わらない場合や成功しなかった場合には、ケーブルが正しく接続されているかチェックしてください。
もしくは、アプリケーションを終了させ、対象モニターの電源を一度オフし、数秒経った後、再びオンさせてください。

※アプリケーションが何かの問題で終了してしまった場合もこの方法を試してください。
・ コネクト中に"Cancel"ボタンをクリックすれば中断することができます。

Monitor Calibrationツールの使い方
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３．フォトメーターとPCの接続（コネクト）

① フォトメーターの電源を入れセットアップしてください。
②フォトメーターをケーブルでPCに接続してください。
③ メニューバーから、"Extension"→"Sensor"に入り、使用するフォトメーターを選択してください。
アプリケーション上の"Topology"部分に選んだフォトメーターの画像が表示されます。
※フォトメーター画像をクリックすることでもフォトメーターを選択することができます。

④アプリケーション上の"Measure"ボタン、または"Calibrate"ボタンをクリックしてください。
フォトメーターとPCの通信の確立（コネクト）が開始されます。
コネクトが完了すると、コネクションラインが緑色に変わります。
※ Target Gammaを一つ以上チェックしていないと、"Measure"ボタン、"Calibrate"ボタンは有効になりません。
・ もしコネクトが終わらない場合や成功しなかった場合には、ケーブルが正しく接続されているかチェックしてください。
そして、フォトメーターがWindowsシステムにデバイス認識されているか確認してください。
もし認識されていなかった場合には、おそらくドライバーが正しくインストールされていないと思われます。
そのような場合にはフォトメーターのドライバーを再インストールしてください。

・ コネクト中に"Cancel"ボタンをクリックすれば中断することができます。

※上記で、"Calibrate"ボタンをクリックした場合、キャリブレーションプロセスに進みます。
もし、キャリブレーションパラメータを変更したい場合は、"Abort"ボタンをクリックして動作を中断してください。

Monitor Calibrationツールの使い方
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４．キャリブレーションパラメータの設定

ガンマ/最大輝度

①調整したいガンマLUTのチェックボックスをクリックしてください。複数選択可能です。
ここでチェックマークがついているガンマLUTがキャリブレーション対象となります。

② ターゲットガンマ値を設定してください。（設定可能範囲：1.0～3.0）
初期値は、LUT#1＝2.2, LUT#2＝2.35, LUT#3＝2.45, LUT#4＝2.6です。
LUT#2～4および、DICOM93、DICOM65の選択可否は、対象モニターの機種によって変わります。

③ガンマの調整ポイント数を設定してください。（16, 32, 64, 128, 256）
初期値は、"16"です。
ポイント数が多ければ（特に低階調部において）ガンマ調整結果は良くなりますが、調整時間は長くなります。

（調整時間の目安）
・ 16…約3分、32…約5分、64…約8分、128…約14分、256…約25分
ただし、調整環境、フォトメーターの種類等の測定条件によって変わります。上記の時間はあくまで目安です。

④ ターゲット最大輝度値[cd/m
2
]を設定してください。

※対象モニターの最大輝度を上回る輝度値に設定にした場合、対象モニターの最大輝度値に自動的に設定されます。
同様に、対象モニターの最小輝度を下回る輝度値に設定にした場合、対象モニターの最小輝度値に設定されます。

※対象モニターの最大輝度および最小輝度は自動的に測定され、"Monitor Capability"の部分に表示されます。
※ DICOMターゲット輝度は、DICOM対応機種のみ設定できます。
※この設定は主に、複数のモニター間で表示輝度を合わせる目的で使用されます。

ホワイトバランス

① "White Balance"部分のタブで設定色温度を選択します。
9300K、6500K、USERが選択可能です。
9300Kは9314Kをターゲットとして、6500Kは6504Kをターゲットとして設定されており変更はできません。

② USERは色温度のターゲットを3000～10000Kの範囲で変更可能です。
"Color Temperature"のテキストボックスか、"x", "y"のテキストボックスから設定できます。
"x", "y"に値を入力した場合、計算された色温度が"Color Temperature"に反映されます。

※ DICOM対応機種では、DICOM93は9300K、DICOM63は6500Kをターゲットとして調整されます。

①
②

③

④

①

②

Monitor Calibrationツールの使い方
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５．キャリブレーションの実行

①アプリケーション上の"Calibrate"ボタンをクリックするとキャリブレーションプロセスが開始されます。
もしモニターおよびフォトメーターのコネクトをしていなかった場合は、コネクトプロセスが行われます。

②下記のダイアログが表示されますので、どちらかのキャリブレーションモードを選択して"OK"ボタンをクリックしてください。

・ ガンマ/ホワイトバランス（輝度）を調整するモード
・ ホワイトバランス（輝度）のみ調整するモード
・ "Don't ask me next time"にチェックマークを付けた場合は、次回からこのダイアログはスキップされます。
またこのダイアログを表示するようにしたい場合は、メニューバーからExtension→Calibration Modeに入り、
"Please ask at the beginning of calibration"を選択してください。

キャリブレーションパラメータや設定を変更したい場合は、"Abort"ボタンをクリックすることで、
キャリブレーションプロセスを中断することができます。

③下記のダイアログが表示されますので、NVRAM（画質データ）をバックアップするか選択してください。
データをバックアップしたい場合は"Yes"、しない場合は"No"を選択してください。
※ NVRAM：Non Volatile RAM。不揮発性RAM。
※ メニューバーから、"File"→"Save NVRAM"でも同様のバックアップが可能です。
・ "Don't ask me next time"にチェックマークを付けた場合は、次回からこのダイアログはスキップされます。
またこのダイアログを表示するようにしたい場合は、メニューバーからExtension→Backup Optionに入り、
"Please ask at the beginning of calibration"を選択してください。

Yesを選択した場合、NVRAMデータの保存先を選び保存してください。
※保存したNVRAMデータは、本アプリケーションのロード機能でモニターに書き込み、保存時の状態に戻すことができます。

保存が完了するまで多少の時間がかかります。この間、モニターの電源はオフしないでください。
保存が完了すると自動的に次へ進みます。

バックアップ完了時

Monitor Calibrationツールの使い方
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④下記ダイアログが表示されます。
このダイアログウインドウをドラッグ＆ドロップで、キャリブレーションを行うモニターの画面上に移動させ、
"OK"ボタンをクリックしてください。
モニターの画面に調整用テストパターンが表示され、キャリブレーションが開始されます。

⑤キャリブレーションが開始されると、メインアプリケーションウインドウは最小化され、
下記キャリブレーションステータスウインドウが表示されます。

ホワイトバランス（輝度）のみ調整するモード時

・ ガンマ調整は、①測定/解析　②LUTデータ書き込み　③確認検査の３ステップで行われます。
・ ホワイトバランス調整は、①ゲイン/オフセット調整　②データ書き込み　③確認検査の３ステップで行われます。

プログレスバーは各ステップの進行状況を示しています。完了したステップにはチェックマークがつきます。
"Cancel"ボタンをクリックすれば、キャリブレーションを中断し、メインウインドウに戻ることができます。

※ガンマ調整中にステータスウインドウがテストパターンによって隠れてしまっている場合には、
キーボードのESCキーを断続的に数回押下することでもキャリブレーションを中断させることができます。

すべてのステップが完了すると、下記画面になります。
OKボタンをクリックするとメインウインドウが再表示され、レポートウインドウが新たに開きます。

ホワイトバランス（輝度）のみ調整するモード時

Monitor Calibrationツールの使い方
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６．キャリブレーションレポート

ガンマとホワイトバランス（CCT)のキャリブレーション結果が表示されます。
・ キャリブレーションを行った各ガンマLUTと色温度の結果を表示させることができます。
・ 上部のタブでレポート種類を切り替えることができます。（「輝度＆CCTグラフ」又は「トラッキンググラフ（無彩色＝グレー）」）
※ホワイトバランス調整のみ行った場合はガンマカーブは表示されません。

このウインドウでは、過去レポート表示(Open)、レポートの保存(Save As)、レポート印刷(Print)ができます。

輝度＆CCTグラフ

cd/m
2
（ログスケール）、MK

-1
表示時

・ 輝度は「％」と「cd/m
2
（ログスケール）」で表示することができます。

・ CCTの単位は「K」または「MK
-1
」で表示することができます。

※ MK
-1
（毎メガケルビン）とは従来のミレッドという単位と同じで、最新のSI単位です。

ミレッドとは、色温度の逆数に10
6
を掛けた数値です。

・ マウスポインターをグラフ上で1.5～2秒置いておくと、座標情報が表示されます。
・ グラフ上で左クリックしてエリアを選択後再び左クリックをすると、任意のエリアを拡大表示させることができます。
右クリックをすれば元に戻ります。

トラッキンググラフ（無彩色）
拡大表示時

・ マウスポインターをグラフ上で1.5～2秒置いておくと、座標情報が表示されます。
・ グラフ上で左クリックしてエリアを選択後再び左クリックをすると、任意のエリアを拡大表示させることができます。
右クリックをすれば元に戻ります。

Monitor Calibrationツールの使い方
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過去のレポートを開く

レポート右上にある"Open"ボタンをクリックすると、過去に保存したレポートファイルを開くことができます。
任意のレポートファイル(～.rpt)を選択してください。

※レポートを新たに開いてしまうと、開く前のレポートへは戻れません。
キャリブレーションが完了した後、過去レポートを開く場合は、先に保存しておくことをおすすめします。

レポートを保存する

レポート右上にある"Save As"ボタンをクリックすると、レポートファイル(～.rpt)を保存することができます。
任意の名前で保存してください。

レポートを印刷する

レポート右上にある"Print"ボタンをクリックすると、現在表示されているレポート画面を印刷することができます。
任意の方法で印刷してください。

７．アプリケーションの終了

メニューバーから、"File"→"Exit"を選択すると、下記ウインドウが表示されますので、
"Yes"を選択し、アプリケーションを終了させてください。

Monitor Calibrationツールの使い方
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◆トラブルシューティング◆

症状 確認、対処方法
１．モニターとの通信の確立（コネクト）がで
きません。

・電源コード（プラグ）が正しく差し込まれており、パワースイッチがオンされていることを確認してくださ
い。
・正しいシリアルケーブルが使われていることを確認してください。
・シリアルケーブルがモニターとPCに接続されていることを確認してください。
・モニターの通信インターフェース設定が"RS232C"となっていることを確認してください。（詳細は各モニ
ターの取扱説明書をご参照ください。）
・お使いのPCのOSが対応バージョンであることを確認してください。
・USB-Serial変換アダプターをお使いの場合は、PCに正しく認識されているか確認してください。また、
必要であればドライバーをアップデートしてください。
・上記の項目でもまだ解決できない場合には、一度モニターの電源コードを抜き、数秒待ってから再度
電源コードを差し込み、モニターを起動させてください。本アプリケーションが正常終了しなかった場合に

２．フォトメーターとの通信の確立（コネクト）
ができません。

・電源コード（プラグ）が正しく差し込まれていることを確認してください。（CA-210の場合）
・フォトメーターがPCに正しく接続されていることを確認してください。
・お使いのフォトメーターが対応モデルであることを確認してください。
・フォトメーターのドライバーが最新であることを確認してください。必要であれば最新のドライバーをダウ
ンロード、インストールしてください。（詳細は各フォトメーターの製造元にお問い合わせください。）
・USB接続の場合、PCに正しく認識されているか確認してください。ケーブルの交換、ドライバーのアップ
デートにより解決できる場合があります。

３．フォトメーターの認識通信中にアプリ
ケーションが異常終了してしまいました。

・本アプリケーションのウインドウをすべて閉じ、再度本アプリケーションを実行してください。

４．NVRAMデータがロードできません。 ・本アプリケーションの対応モニターであることを確認してください。
・正しくモニターとの通信の確立（コネクト）がされていることを確認してください。
・ロードしようとしているNVRAMデータがお使いのモニターのデータであることを確認してください。
（NVRAMは各モニターモデル毎にセーブされています。よって、別モデルのモニターにはロードできませ
ん。）

５．ホワイトバランス調整が開始されませ
ん。

・お使いのPCのグラフィックカードがDVI-D出力できることを確認してください。
・DVI-DケーブルでPCとモニターに接続されており、PCの映像が表示されていることを確認してくださ
い。
・マルチ画面にて表示中の場合は、キャリブレーションプロセス実行時に表示される"Get Cursor
Position"ウィンドウを、キャリブレーションを行いたいモニターにドラッグ＆ドロップして移動させてから

６．輝度が目標通りに調整できません。 ・各モニターの性能以上または以下の輝度に調整することはできません。ターゲット輝度の値を変更して
ください。
・フォトメーターの精度バラツキによっても結果が異なる場合があります。フォトメーターの校正を正しく
行ってください。

７．色温度が目標通りに調整できません。 ・フォトメーターの精度バラツキによっても結果が異なる場合があります。フォトメーターの校正を正しく
行ってください。
・特に輝度の低い信号レベルにおける色温度はフォトメーターの測定精度やバックライト光の漏れによっ
て正しく調整できない場合があります。
・色温度が高い領域においては、CIExyの測定値の差が色温度値への計算結果に大きく影響します。
よって、測定値によってターゲットからのずれが大きくなる場合があります。
・CIEｘｙ-色温度又はその逆の計算において変換エラーが起こる場合があります。

８．ホワイトバランスがばらついてしまいま
す。

・キャリブレーション用テストパターンが正しく表示されていない可能性があります。DVI-Dケーブルのコ
ネクタがしっかり差さっていること、ピンが折れ曲がっていないことを確認してください。
・測定中に環境光が入り込んでしまっている可能性があります。フォトメーターの設置、設置環境を確認
してください。
・ホワイトバランスの調整レベル（Offset）が低すぎる可能性があります。調整レベル値を上げて再度お
試しください。（メインウインドウ画面の説明　①メニューバー　・White Balanceをご参照ください。）

９．ホワイトバランス調整中に、プログレス
バーが戻ってしまいます。

・プログレスバーはあくまで目安であり、ターゲット色温度によっては調整時間が長くなってしまう場合が
あり、予想よりも調整に時間がかかることを示すためにプログレスバーを後退させることがあります。

１０．ガンマ調整中にキャリブレーションス
テータスウインドウが消えてしまいます。

・ガンマ調整中の①測定/解析フェーズ、③確認検査フェーズではモニター内のテストパターンを使用し
ます。このテストパターンはDVI-D信号の上から表示するため、ステータスウインドウが消えてしまいま
すが、正常な動作です。

１１．ガンマ調整は中断できますか？ ・ガンマ調整中にステータスウインドウがテストパターンによって隠れてしまっている場合には、キーボー
ドのESCキーを断続的に数回押下することでもキャリブレーションを中断させることができます。

※その他、本アプリケーションに関するご質問は、弊社ホームページの所定フォームよりお問い合わせください。
　 http://www3.jvckenwood.com/support/mail/pro_sys.html

トラブルシューティング
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■ 変更履歴

変更日 変更番号 変更内容 備考

2016.12.22 00 ・新規作成
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